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Difficulty Opening a File? Use These Tips to
Identify and Solve the Problem

It should be easy: you download a file, receive
one by email, or copy one to another comp-
uter, and double-click the file to open it. You’re
expecting a program to appear and display the
file’s contents, but instead you see a message
saying that Windows can’t open the file. Or
perhaps the file opens in a program you
weren’t expecting to see and don’t want to
use. What’s gone wrong, and what can you do
to put it right? Read on to find all the answers.
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This article shows you:
• Why certain files open with particular programs
• How to open files using the program you prefer
• How to deal with files that Windows can’t open
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How Windows Knows Which Programs to Use

You’re looking through the contents of
your Documents folder one day when
you come across a file whose icon looks
like the one pictured to the right. When
you double-click it, a program named
Notepad opens and displays the contents
of this file.

That’s likely to be just what you hoped for and expected,
but why does it happen? How does Windows know that
this particular file should be opened using Notepad
rather than one of the many other programs on your PC?

It’s made possible by two things: ‘file extensions’ and ‘file
associations’. Don’t be put off by the slightly-technical
names; they’re both quite straightforward:

File extensions

The name of every file ends with something called the
file extension. This consists of a dot and several more
characters – usually three, and usually all letters, but there
are no particular rules about it.

You won’t generally be aware of these file extensions
because Windows hides them. If you look through your
Documents folder and notice a file named User Manual,
its full name might be User Manual.txt or User
Manual.docx or User Manual.pdf, but Windows has
hidden that dot and the last few characters – the file
extension.

Why does Windows hide the file extension? There are
several reasons. One is that it looks rather technical and
off-putting: when you choose a name for a file, that’s the
name you want to see – you don’t want to see extra
characters tagged on the end! A second reason is that if

File Trouble: Which Program Do I Need? 
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file and a suitable

program displays it

Two Windows
features work

together

The hidden ‘file
extension’
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you could see the file extension, you might accidentally
delete it or change it while renaming a file, and that
could be troublesome. Third, the use of ‘file associations’
(explained below) should make it unnecessary to see the
file extension.

File associations

On your computer, Windows keeps a list of the file
extensions it knows about. Whenever you double-click a
file, Windows looks up its file extension in that list.
Provided that file extension does appear in the list, it
should be accompanied by the details of one particular
program on your computer. Windows starts that program
and tells it to open the file you double-clicked.

This system of matching a particular file extension to a
particular program is known as a ‘file association’: each
file extension is associated with (or linked to) a certain
program.

File associations perform another useful service: they
determine which icons we see for particular files. As an
example, take the three files pictured below. The reason
they look like this is that Windows has looked up their
extensions in that list, discovered which program each of
these files is associated with, and assigned each file an
icon that corresponds with its associated program.

That gives us another reason why we don’t need to see
file extensions at the end of every file’s name: the icon

File Trouble: Which Program Do I Need? 
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A list matching
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icon for its files
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tells us at a glance what type of file we’re looking at and
which program will open it.

Taking the file in the middle of the three pictured above,
its full name including file extension is actually Mac
mini.docx, although as always Windows is hiding the
‘.docx’ part. The .docx file extension is associated with
the program Microsoft Word, and Windows therefore
displays a Microsoft Word icon for this file. So we don’t
need to know or care what its file extension is – we can
see at a glance that it will be opened using Microsoft
Word if we double-click it.

Sometimes you’ll see file extensions shown in all-capitals
(.DOCX), sometimes in small letters (.docx), but it makes
no difference. As far as Windows is concerned, both
mean exactly the same. (And so does .DoCx: that would
be an unusual way to type it, but a perfectly valid way.)

As simple and foolproof as it seems?

So this vital aspect of your PC – the ability to open your
files using the correct programs for them – is governed
by two rules:

• Every file’s name has a file extension (although
Windows generally hides it from you), whether it’s a
file you create yourself, download from a website or
receive by email.

• Windows keeps a list of file extensions and uses it to
determine which icon to display for a certain file
and which program to use for opening that file.

It seems simple enough – what could possibly go wrong?

Well, there are a couple of potential problems and I’ll
tackle them later in this article, but here’s a quick
introduction to them:

20 August 2022
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• It’s possible that you’ll receive or download a file
whose extension doesn’t appear in that list. In that
case, Windows won’t know which program should
be used to open it and won’t
know what icon to display for it. It
gets around the second of those
issues by displaying a bland icon
that matches none of your
programs (and it doesn’t hide the
file extension in this case), but
how can you open the file?

• You might find one day that some of your files have
started opening with a different program – usually
a program you’ve installed recently – and are
possibly showing a different icon too. Why has this
happened, and how can you make them open with
the familiar program that was always used before? 

Quickly Check a File’s Extension and
Association

Once in a while you may want to find out what a
particular file’s extension is and see which of your
programs it’s associated with. Fortunately, this is quick
and easy – just follow these steps:

1. Right-click the file and choose Properties.

2. In the dialog that opens, pictured in the next
screenshot, you’ll see the file’s icon and its name near
the top. Below that, alongside the words Type of
file, you’ll see a description of the type of file it is
and in brackets beside that its file extension .
Beside the words Opens with you’ll see the name of
the program used to open this type of file – the
file’s associated program.

1

2

3

21August 2022

Windows may not
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extension
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3. Click the Cancel button at the bottom of the dialog
(or press the Esc key on your keyboard) to close the
dialog.

If you want to know the extensions of a number of
files, it’s rather longwinded to display the Properties
dialog for each of them in turn. A better option is to
tell Windows to display all file extensions temporarily.
After opening File Explorer and making your way to
the folder you're interested in, do the following
according to your version of Windows:

• Windows 11: click the View button on the toolbar,
move the mouse down to Show and choose File
name extensions.

• Windows 10 or 8.1: switch to the View tab on the
Ribbon, and in the ‘Show/hide’ group tick the box
beside File name extensions.

• Windows 7: click the Organise button and choose
Folder and search options. In the dialog that
appears, select the View tab, remove the tick beside
Hide extensions for known file types and click OK.

Now Windows will display the file extensions for every
file on your computer as you move between folders.

22 August 2022
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It’s possible for file names to contain several dots – you
might have chosen a name like Party 12.7.2021 for one
of your files. Nevertheless, the extension begins with the
very last dot you see in the name when file extensions
are being displayed, so if this file were a text document,
Windows would now be displaying its name as Party
12.7.2021.txt, indicating that its extension is ‘.txt’.

After checking the extensions you wanted to know, it’s
wise to turn off the display of file extensions again by
repeating the same steps you followed a moment ago.

Why Do Files Suddenly Open in a 
Different Program?

You probably get used to things looking a certain way
on your PC, and one day you might open one of your
folders and notice that the files inside it look a little
different from usual: some of their icons have changed.

More tellingly, you might double-click one of these files
to open it and find that you’re now seeing a different
program from the one that always used to open this
file. What’s happened?

The likelihood is that you’ve recently installed a new
program on your PC, and that this new program has
‘stolen’ the association for that type of file.

I’ll explain how this happens with an example. Recent
versions of Windows come with an app named Photos

23August 2022

Certain icons
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which is able to display various types of picture files. The
various extensions used by picture files are all associated
with this program, so whenever you double-click a pic-
ture file, it’s this Photos app that opens and displays it.

Where the Photos app falls down is that its editing
features are fairly basic, so one day you might decide to
install a picture-editing program. During the installation,
the new program changes all those associations, setting
itself as the program to open picture files. So, next time
you double-click a picture, it’s this new program that
opens it rather than the Photo app.

In fact, a responsibly-designed program should ask you
during installation whether you want it to be associated
with compatible types of file, or whether you’d prefer to
leave your file associations as they are. However, some
programs certainly do ‘steal’ associations for themselves
without asking, or you might allow this to happen
without understanding what you’re being asked.

If a new program has ‘stolen’ a file association for itself,
and you want to change it back to the program that
was always used before, here’s what to do:

1. Right-click one of the files that’s now opening with
the wrong program.

2. Move the mouse down to the Open with item.

3. In Windows 11 or 10, click on Choose another app. In
Windows 8.1 or 7, click on Choose default program.

4. In the window or panel that opens you’ll see a list of
programs, any of which should be able to open the
type of file you right-clicked in step 1. If you can see
the program that was always used in the past – the
program you want to use in future – click its name to
select it.

24 August 2022
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5. Having selected the program you want to use, tick
the box beside Always use this app to open
[extension] files (the wording varies from one
version of Windows to another, but it’s similar
enough that you’ll recognise the option).

6. Finally, click OK. Windows will now open the file you
chose in step 1 using this program. It will also rem-
ember that this is the program you want to use in
future, resetting the association for this type of file.

If you’re not sure which of these programs was used
before, choose a program from the list (and make a
mental note of which you’ve chosen), but remove the
tick alongside Always use this app before clicking OK.

25August 2022
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Windows will then use the program you’ve just chosen
to open the file, but without changing the association –
this gives you a way to see whether this is the right
program (or at least a suitable one). If it isn’t, follow the
same steps again to try a different one; if it is, repeat
the steps to choose the same program, but this time tick
the box beside Always use this app.

What to Do if Windows Can’t Open a File

Once in a while you might download a file from a
website or – more likely – receive one as an email
attachment, and discover that Windows can’t open it.
When you try, you see a message like this:

An important point about file extensions and
associations is that Windows doesn’t know about all of
them! Unless there’s a program already on your PC that
is capable of opening the kind of file you’ve received,
and that program has added itself to Windows’ list of
file associations, Windows won’t know what to do with
the file when you try to open it.

26 August 2022
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If you do see the message pictured above, it’s a fairly
safe bet that you don’t have a program on your PC that’s
capable of opening the file you’ve received. It’s not
absolutely a foregone conclusion though: if you believe
that one of your programs should be able to open the
file, you can choose between two options:

• Click the words More apps in the dialog pictured
above. This will then display a list of programs similar
to the one pictured on page 9. The list will probably
be longer, as Windows will include as many programs
as it can: choose the one you believe can open the file
you’ve received and click OK. If you kept a tick beside
Always use this app to open [extension] files, Wind-
ows will create an association between the type of
file you received and the program you’ve just chosen
to open it so that, in future, you can double-click one
of these files to open it in the same program.

I’d suggest that it’s a good idea not to tick the box
beside Always use this app to open [extension] files
initially. Doing so would create an association between
this type of file and the program you’ve chosen, hide the
extensions of those files and give them an icon that
matches the program. That could all be rather confusing
if it turns out that the program you’ve chosen can’t
actually open these files! (While creating an association
is easy, removing one certainly isn’t.) Instead, as I
mentioned before, leave this option unticked while
you’re simply finding out whether a program is suitable;
if you find it is, you can repeat the procedure and tick
this option to create the association.

• If the dialog above appears, either press Esc or click
somewhere outside the dialog to make it close. Now
start the program you believe is able to open this
kind of file. When the program starts, use its File >
Open (or equivalent) option to browse to the file

27August 2022
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you’ve received and open it. If the file opens and
displays correctly, you know this program is indeed
capable of opening the type of file you’ve received.
You could close the program, then right-click the file
and follow the steps on page 8 to associate it with the
program you’ve just confirmed to be compatible.

The other thing you can do in this dialog is to choose
Look for an app in the Microsoft Store and click OK.
This opens the Store and runs a search for the extension
of the file you were trying to open: the search results list
any app that mentions the extension somewhere in its
description. Have a look through those apps to read
about them and see whether something seems a
suitable choice.

Windows 7 does things a little differently from what I’ve
described above. Besides offering you a list of installed
programs to choose from, its other option is Use the
Web service to find the correct program. Years ago
this might have been useful. Nowadays, however, it
simply opens your web browser and uses the Bing search
engine to search for the extension (something you could
easily do yourself at Bing or elsewhere).

An alternative to any of the above is to use a handy
website named OpenWith.org. This site maintains a list
of known file extensions and the programs that work
with them, making it a good place to look up an
unrecognised extension.

Start your favourite web browser and visit
www.openwith.org. When you arrive, type the
extension into the search
box at the top-left of the
page (with or without its
opening dot – either will
work) and press Enter.
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Now you’ll see a web page listing one or more programs
that can open files with the extension you typed. These
are all free programs, and the website explains what
each can do (for example, whether a program can only
open a document for reading or whether it also allows
you to edit and save documents). 

For any program that seems suitable, you can either click
the Download Now link to begin downloading it
straight away, or click the Website link to visit the
program’s website and find out more about it first.

Quick Reference: Common Files and 
Their Programs

Whenever you come across a file whose extension you
don’t recognise, here’s the best way to find out what it
is: just look it up in the alphabetical list below for an
explanation of what it is and which program(s) can
open it. Unless otherwise noted, the programs reco-
mmended below are free.

29August 2022

Free programs with
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Not sure what it is?
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Extension Description Notes (see
page 20)

.7Z A type of compressed
archive file similar to a
zip (.ZIP) file. You can
use 7-Zip from www.7-
zip.org to open these.

3

.ACCDB A database file created
by Microsoft Access
2007 or later (not free).
MDB Viewer Plus from
www.alexnolan.net
can open these.
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.ASF An audio and/or video
file. Windows Media
Player can open these,
as can VLC Media
Player from
www.videolan.org.

3

.AVI A video file. Windows
Media Player can play
most of these. VLC
Media Player from
www.videolan.org
should play any that
Windows Media Player
can’t. 

2, 3

.BAT A ‘batch file’ – a type
of program containing
potentially-
dangerous commands.

1

.BMP A Windows Bitmap
picture file. The Paint
accessory can open
these.

2

.CPL A Control Panel
program.

1

.CSV Comma Separated
Values file. Microsoft
Excel (not free) can
open these, as can
LibreOffice from
www.libreoffice.org.

2

DOC A Microsoft Word
document. All versions
of Word (not free) can
open these, as can
LibreOffice
(www.libreoffice.org).
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.DOCX A Microsoft Word
document. Word 2007
and later (not free) can
open these, as can
LibreOffice
(www.libreoffice.org).

.EXE A program. 1

.FLV A Flash Video file. VLC
Media Player from
www.videolan.org can
play these.

3

.GIF A picture file. The Paint
accessory can open
these.

2, 3

.ISO A file containing the
contents of a CD or
DVD. 7-Zip from
www.7-zip.org can
open these.

2

.JPG/.JPEG A picture file. The Paint
accessory can open
these.

2, 3

.JS A JavaScript file – a
type of program
containing potentially-
dangerous commands.

1

.M4A An audio file. VLC
Media Player from
www.videolan.org can
play these.

2, 3

.M4V An audio file. VLC
Media Player from
www.videolan.org can
play these.

2, 3

PCS_8_AUGUST_2022_F258_20pp_mrg  10/06/2022  11:29  Page 31



F 258/16

32 August 2022

File Trouble: Which Program Do I Need? 

.MDB A database file created
by Microsoft Access
(not free). MDB Viewer
Plus from
www.alexnolan.net can
open these.

.MOV A ‘QuickTime movie’
video file. VLC Media
Player from
www.videolan.org can
play these.

2, 3

.MP3 An audio file. Windows
Media Player can play
these, as can VLC
Media Player from
www.videolan.org.

2, 3

.MPG/.MPEG A video file. Windows
Media Player can play
these, as can VLC
Media Player from
www.videolan.org.

2

.ODT A text document.
Microsoft Word (not
free) can open these as
can LibreOffice
(www.libreoffice.org).

1

.ODB A database file.
Microsoft Access (not
free) can open these as
can LibreOffice
(www.libreoffice.org).

2
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.ODP A presentation file.
Microsoft PowerPoint
(not free) can open
these as can LibreOffice
(www.libreoffice.org).

2

.ODS A spreadsheet file.
Microsoft Excel (not
free) can open these as
can LibreOffice
(www.libreoffice.org).

2

.OGG An audio or video file.
VLC Media Player from
www.videolan.org can
play these.

3

.OTF An OpenType font file.
Double-click to
preview; right-click to
install.

.PNG A Portable Network
Graphics picture file.
XnView
(www.xnview.com) can
open these.

2, 3

.PPS/.PPT A Microsoft
PowerPoint
presentation.
PowerPoint (not free)
can open these, as can
LibreOffice
(www.libreoffice.org).
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.PSD An Adobe PhotoShop
picture file. XnView
(www.xnview.com) can
open these.

3

.PSP A Paint Shop Pro
picture file. XnView
(www.xnview.com) can
open these.

3

.RAR A type of compressed
archive file similar to a
zip (.ZIP) file. You can
use 7-Zip from 
www.7-zip.org to 
open these.

3

.REG A Registry file. 1

.RTF A Rich Text document.
The WordPad accessory
can open this, as can
most word processors.

2, 3

.SCR A screensaver file (a
type of program).

1

.TIF/.TIFF A picture file. XnView
(www.xnview.com) can
open these.

2, 3

.TTF A TrueType font file.
Double-click to preview;
right-click to install.

.TXT A plain text file. The
Notepad accessory (and
any word processor)
can open these.

2, 3

PCS_8_AUGUST_2022_F258_20pp_mrg  10/06/2022  11:29  Page 34



F 258/19File Trouble: Which Program Do I Need? 

35August 2022

.VB/.VBS VBScript file – a type of
program containing
potentially-dangerous
commands.

1

.WPS A Microsoft Works text
document. Microsoft
Word (not free) can
open these, as can
LibreOffice
(www.libreoffice.org).

.XLR A Microsoft Works
spreadsheet.
LibreOffice
(www.libreoffice.org)
can open these.

.XLS A Microsoft Excel
spreadsheet. All
versions of Excel (not
free) can open these, as
can LibreOffice
(www.libreoffice.org)

1

.XLSX A Microsoft Excel
spreadsheet. Excel 2007
and later (not free) can
open these, as can
LibreOffice
(www.libreoffice.org).

2, 3

.ZIP A compressed archive
containing one or
more files. 7-Zip from
www.7-zip.org can
open these.

2, 3
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Notes:

1. Files with this extension are potentially dangerous.
Don’t try to open the file unless you know it’s safe to
do so. If you received the file by email, even from
someone you know and trust, be very suspicious of
it. At the very least, contact them to ask if they
meant to send you this type of file.

2. This is a standard type of file which many programs
can open. If double-clicking the file doesn’t open it,
start any program that should be compatible and
choose File > Open (or equivalent) then find and
select the file you want to open. If the file doesn’t
appear in the ‘Open’ dialog, type an asterisk
(Shift+8) into the File name box and press Enter to
make it display all types of files.

3. When installing a new program to open this type of
file, the program may offer to associate itself with
other types of files – files which you’re already able
to open with an existing program. Consider
associating it only with this particular type of file, or
associate it with none and use the method outlined
in Note 2 above to open files.

File Trouble: Which Program Do I Need? 
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